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Allgemeine Einführung: Scantools-Funktionen
Scantools bietet Ihnen eine Reihe von Werkzeugen für das Transformieren von importierten Flächen,
Sammelflächen, Triangulationsdaten oder Rohdaten in fertigungstaugliche Modelle.

Mit Scantools können Sie die folgenden Tasks ausführen:
� Rohdaten importieren, erzeugen und filtern

� Geometrien importieren, einschließlich Kurven, Flächen und facettierte Daten

� Kurven erzeugen und ändern

� Geometrie manuell oder automatisch heilen (nur mit einer Lizenz für Import Data Doctor)

� Geometrie aus späteren KEs in das Style-KE verkleinern (mit einer Lizenz für Import Data Doctor)

Hinweis: Wenn Sie ein Import-KE in der Scantools-Umgebung umdefinieren, können Sie die Scantools-
Funktionalität zusätzlich zu den standardmäßigen Werkzeugen zum Umdefinieren von Import-KEs
(Redefine Import) verwenden.

Empfohlene Verwendung

Die Applikation Style ist zwar die empfohlene Umgebung für parametrische Styling-Operationen, die
Verwendung von Scantools wird jedoch für das Erzeugen von Formen aus nicht-parametrischen Daten (d.h.
Rohdaten und importierte Geometrie) empfohlen.

Scantools-Objekte

In Scantools können Sie mit den folgenden Objekten arbeiten: Sammelflächen, Flächen, Kurven und
Rohdaten.

In Scantools können Sie nur eine begrenzte Anzahl von nicht-analytischen Geometrien ändern. Sie können
Scantools auch für das Kopieren und Konvertieren von vorhandenen Kurven oder Flächen in ein
bearbeitbares Element verwenden. Um z.B. einen Zylinder ändern zu können, müssen Sie diesen zunächst
über die Befehlsfolge Flaeche > Von Flaeche (Surface > From Surface) in eine Splinefläche
konvertieren.

Wenn Sie über eine Lizenz für Import Data Doctor verfügen, können Sie alte Scantools-Objekte (z.B.
Kurven und Flächen) importieren, indem Sie diese in die Scantools-Geometrie verkleinern.

Allgemeine Einführung: Die Scantools-Umgebung
Scantools ist eine nicht-parametrische Umgebung, die es Ihnen ermöglicht, sich auf einen bestimmten
Bereich des Modells zu konzentrieren und eine Vielzahl von Werkzeugen zu verwenden, um die
gewünschte Form und die gewünschten Flächeneigenschaften zu erzielen.

Für die Isolierung Ihrer Konstruktionsaktivitäten in einem einzelnen KE verwendet Scantools das "Style-
KE"-Konzept. Wenn Sie auf Scantools zugreifen, arbeiten Sie mit einem Style-KE. Das Style-KE ist ein
übergreifendes KE, das alle Geometrien und Referenzdaten umfaßt, die in Scantools erzeugt oder
importiert wurden.

Alle im Style-KE importierten und erzeugten Geometrien werden Bestandteil des Style-KE. Interne
Objekte des Style-KE (einzelne Flächen, Kurven usw.) weisen keine Eltern-Kind-Abhängigkeiten
außerhalb des Style-KE oder untereinander auf. Auf diese Weise können Sie Flächen beliebig bearbeiten,
ohne Referenzen und Eltern-Kind-Beziehungen zwischen Style-KE-Objekten und dem Rest des Modells
beachten zu müssen.

Hinweis: In Scantools können Sie mit allen Bezugs- und Flächen-KEs arbeiten.

Wenn Sie die Scantools-Umgebung verlassen, speichert das System alle Änderungen im Style-KE.
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In Scantools können Sie die Tool-Leiste auf der rechten Seite verwenden, um auf einige der gängigsten
Befehle zuzugreifen:

Auswahl

Widerrufen

Noch einmal

Ändern

OK

Abbrechen

Allgemeine Einführung: Erste Schritte in
Scantools
Wenn Sie über die Befehlsfolge Konstr Element > Erzeugen > Unabhaengige Geometrie (Feature >

Create > Independent Geometry) auf Scantools zugreifen, erzeugt das System ein leeres Style-KE. Es
gibt mehrere Möglichkeiten für das Belegen des Style-KE:

� Rohdaten aus einer Datei importieren

� Vorhandene Geometrie in das Style-KE verkleinern (mit einer Lizenz für Import Data Doctor)

� Kurven und Flächen über Werkzeuge im stilspezifischen Menü Geometrie (Geometry) erzeugen

In der Regel beginnen Sie mit einer importierten Geometrie (Rohdaten, die aus einer Datei in Scantools
oder im Import-KE erzeugt wurden, oder Flächen und Kurven eines vorhandenen Import-KE). Sobald das
Style-KE Geometrie enthält, können Sie es als Basis für das Erzeugen von Formen verwenden. Da
Scantools eine Vielzahl von Werkzeugen für die direkte Flächenmodellierung bietet, müssen Sie je nach
dem von Ihnen verwendeten Datentyp u.U. verschiedene Vorgehensweisen wählen.

In der folgenden Tabelle sind einige der möglichen Szenarios aufgeführt:

Schritt 1 Schritt 2

Importieren von Rohdaten über Geometrie >

Beispieldaten aus Datei (Geometry > Sample

Data from File)

Nachdem Sie überflüssige Daten herausgefiltert
haben, können Sie aus importierten Datenpunkten
Kurven erzeugen. Anschließend können Sie aus den
Kurven Flächen erzeugen.

Importieren von Kurven und Flächen über
Einfuegen > Daten aus Datei (Insert > Data

from File)

Möglicherweise müssen Sie die importierte Geometrie
über die Befehlsfolge Geometrie > Geom heilen

(Geometry > Heal Geometry) berichtigen. Sie
können bei Bedarf weitere Flächen hinzufügen und
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Flächen ändern.

Wenn Sie Geometrie verwenden möchten, die
bereits in Ihrem Pro/ENGINEER Modell
vorhanden ist, können Sie diese Geometrie über
die Befehlsfolge Geometrie > Geometrie

verkleinern (Geometry > Collapse Geometry)

in das Style-KE verkleinern oder über die
Befehlsfolge Geometrie > Flaeche > Von

Flaeche (Geometry > Surface > From

Surface) oder Konstr Element > Kurve > Von

Kurve (Feature > Curve >From Curve) in das
Style-KE kopieren.

Sie können diese Geometrie als Grundlage für das
Erzeugen von neuen Flächen und Kurven verwenden.

Sie möchten mit einem leeren Style-KE
beginnen

Sie können zunächst Kurven und Flächen erzeugen,
indem Sie reguläre Pro/ENGINEER Objekte
(Bezugspunkte, Bezugskurven usw.) referenzieren.
Anschließend können Sie Rohdaten importieren.

Allgemeine Einführung: Rohdaten für das
Erzeugen von Flächen verwenden
Mit Scantools können Sie aus Rohdaten die gewünschten Formen erzeugen. Rohdaten können
beispielsweise wie folgt verwendet werden:

1. Importieren Sie Rohdaten mit hoher Dichte. Verwenden Sie eine der Filtermethoden, um nicht
benötigte Punkte herauszufiltern.

2. Erzeugen Sie Kurven aus importierten Datenpunkten.
3. Erzeugen Sie aus den Kurven Verbundflächen.
4. Bearbeiten Sie die Flächen entsprechend, um die gewünschte Form zu erzielen.

So greifen Sie auf Scantools zu
Zum Erzeugen eines neuen Style-KE wählen Sie die Befehlsfolgen Applikationen > Scantools

(Applications > Scantools) und Konstr Element > Erzeugen > Unabhaengige Geometrie (Feature >

Create > Independent Geometry) oder Einfuegen > Unabhaengige Geometrie (Insert > Independent

Geometry).

Für das Arbeiten mit einem vorhandenen Style-KE wählen Sie die Befehlsfolgen Applikationen >

Scantools (Applications > Scantools) und Konstr Element > Umdefinieren (Feature > Redefine), und
wählen Sie ein Style-KE aus.

So wählen Sie Objekte
Mit Objekttypfiltern können Sie Objekte mit größerer Genauigkeit wählen. Wählen Sie dazu die
Befehlsfolge Editieren > Auswahl (Edit > Select), und wählen Sie einen der folgenden Filter aus:

� Ueber Filter (By Filter) — Objekte werden unter Verwendung des Standardfilters gewählt.

� Flaeche (Surface) — Nur Flächen werden gewählt.

� Sammelflaeche (Quilt) — Nur Sammelflächen werden gewählt.

� Kurve (Curve) — Nur Kurven werden gewählt.

� Beispieldaten (Sample Data) — Nur Rohdaten werden gewählt.

� Filteroptionen (Filter Options) — Standardfilteroptionen für die Methode Ueber Filter (By Filter)

werden festgelegt.
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So speichern Sie Änderungen
Wenn Sie die Arbeiten am Style-KE abgeschlossen haben und die Styling-Umgebung verlassen möchten,
wählen Sie die Befehlsfolge Geometrie > Fertig (Geometry > Done), oder klicken Sie auf einer Tool-
Leiste auf die Schaltfläche Fertig (Done). Das System speichert das KE und beendet die Applikation.

Allgemeine Einführung: Rohdaten importieren
Für das Importieren von Rohdaten wählen Sie die Befehlsfolge Geometrie > Beispieldaten aus Datei...

(Geometry > Sample Data from File...). Sie können Daten mit hoher oder niedriger Dichte importieren.
Beim Importieren von Daten mit hoher Dichte bzw. Punktwolken können Sie verschiedene Filtertechniken
verwenden, um nicht benötigte Datenpunkte zu entfernen und Abtastkurven zu erzeugen, die später für
Styling verwendet werden können.

So importieren Sie Daten hoher Dichte
1. Wählen Sie die Befehlsfolge Geometrie > Beispieldaten aus Datei... (Geometry > Sample Data

from File...).
2. Wählen Sie im Dialogfenster Roh importieren (Import Raw) die Option Hohe Dichte (High

Density).
3. Wählen Sie ein Koordinatensystem.
4. Geben Sie die zu importierende Datei im Dialogfenster Oeffnen (Open) an. Sie können Dateien in den

folgenden Formaten importieren: .igs (punktformatiert), .ibl, .vda oder .pts. Das Dialogfenster
Rohdaten (Raw Data) wird geöffnet.

5. Legen Sie den Prozentsatz von sichtbaren Abtastpunkten fest, indem Sie einen Wert in das Feld
Prozentanteil sichtbarer Punkte (Visible Points Percent) eingeben.

6. Legen Sie die Richtung für die Filterung der Rohdaten fest:
� Abtastkurven (Scan Curves) — Rohdaten werden entlang den Abtastkurven herausgefiltert.

� AutomRichtung-Kurven (Auto Direction Curves) — Das System bestimmt eine optimale
Richtung und erzeugt Kurven aus den ursprünglichen Rohdaten.

� Schnitte (Sections) — Die Punktwolke wird geschnitten, um Rohdatensätze zu erzeugen.

7. Wenn Sie die Option Abtastkurven (Scan Curves) gewählt haben, definieren Sie die Punkte- und
Schnittabstände wie folgt:
� Geben Sie in das Feld Kurvenabstand (Curve Distance) einen Wert für den Abstand zwischen

Abtastkurven ein.

� Geben Sie im Feld Punktetoleranz (Points Tolerance) den Abstand zwischen Punkten ein.

8. Wenn Sie die Option AutomRichtung-Kurven (Auto Direction Curves) gewählt haben, definieren
Sie die Punkte- und Schnittabstände wie folgt:
� Geben Sie im Feld Anzahl der Schnitte (Number of Sections) die Anzahl von Schnitten an, die

für das Schneiden einer Punktwolke verwendet werden.

� Geben Sie im Feld Naehezone (Proximity Zone) die Breite der Zone ein, die an einem Schnitt
entlangläuft. Das System verarbeitet Datenpunkte, die innerhalb dieser Zone liegen, um
Abtastkurven zu erzeugen. Die Nähezone sollte nicht größer sein als der halbe Abstand zwischen
zwei angrenzenden Kurven.

� Geben Sie im Feld Punktetoleranz (Points Tolerance) den Abstand zwischen Punkten ein.

9. Wenn Sie die Option Schnitte (Sections) gewählt haben, definieren Sie den Schnitttyp (Section

Type). Ein Hilfethema zur Definition des Schnitttyps (Section Type) finden Sie unter Siehe auch.
10. Definieren Sie den Punkt-/Schnittabstand (Point/Section Spacing) wie folgt:

� Geben Sie im Feld Naehezone (Proximity Zone) die Breite der Zone ein, die an einem Schnitt
entlangläuft. Das System verarbeitet Datenpunkte, die innerhalb dieser Zone liegen, um
Abtastkurven zu erzeugen.

� Geben Sie im Feld Punktetoleranz (Points Tolerance) den Abstand zwischen Punkten ein.
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11.  Klicken Sie auf Vorschau (Preview) oder auf OK.

So definieren Sie den Schnitttyp
Wenn Sie im Dialogfenster Rohdaten (Raw Data) die Methode Schnitte (Sections) für das Herausfiltern
von Rohdaten gewählt haben, setzen Sie die Task wie folgt fort:

1. Wählen Sie den Schnitttyp:
� Zum Erzeugen von Schnitten unter Verwendung einer Reihe von Ebenen, die parallel zur

Referenzebene sind, klicken Sie auf das Symbol .  Klicken Sie auf die
Auswahlpfeilschaltfläche, wählen Sie eine Referenz aus, und geben Sie die Anzahl von Schnitten
ein. Sie können eines der folgenden Objekte als Referenz wählen:

� Eine Ebene für das Erzeugen von Schnitten. Der rote Pfeil zeigt die Schnittrichtung an.

� Eine lineare Kurve, Kante oder Achse, die die Schnittrichtung definiert.

� Ein Koordinatensystem, das die Schnittrichtung definiert. Wählen Sie die X-, Y- oder Z-
Achse, um die Richtung zu definieren.

� Für das Erzeugen von Schnitten unter Verwendung von ausgewählten Bezugsebenen klicken Sie

auf das Icon . Klicken Sie auf die Auswahlpfeilschaltfläche, um Ebenen zu wählen, und
klicken Sie auf Fertig Ausw (Done Sel).

� Für das Verwenden von Ebenen, die regelmäßige Abstände aufweisen und senkrecht zu einer

ausgewählten Leitkurve sind, klicken Sie auf das Icon . Klicken Sie auf die
Auswahlpfeilschaltfläche, und wählen Sie eine Kurve, die als Leitkurve verwendet werden soll.
Geben Sie die Anzahl von Schnitten ein.

2. Definieren Sie den Punkt-/Schnittabstand (Point/Section Spacing) wie folgt:
� Geben Sie im Feld Naehezone (Proximity Zone) die Breite der Zone ein, die an einem Schnitt

entlangläuft. Das System verarbeitet Datenpunkte, die innerhalb dieser Zone liegen, um
Abtastkurven zu erzeugen.

� Geben Sie im Feld Punktetoleranz (Points Tolerance) den Abstand zwischen Punkten ein.

3.  Klicken Sie auf Vorschau (Preview) oder auf OK.

So importieren Sie Daten niedriger Dichte
1. Wählen Sie die Befehlsfolge Geometrie > Beispieldaten aus Datei (Geometry > Sample Data from

File).
2. Wählen Sie im Dialogfenster Roh importieren (Import Raw) die Option Niedrige Dichte (Low

Density).
3. Wählen Sie ein Koordinatensystem.
4. Geben Sie die zu importierende Datei im Dialogfenster Oeffnen (Open) an. Sie können Dateien in den

folgenden Formaten importieren: .igs (punktformatiert), .ibl, .vda oder .pts.

So verkleinern Sie Geometrie
Sie können das Style-KE belegen, indem Sie parametrische KEs verkleinern, die Sie zuvor in der
Pro/ENGINEER Standardumgebung (mit einer Lizenz für IDD) erzeugt haben. Sobald KEs in das Style-
KE verkleinert sind, verlieren sie zwar ihre parametrischen Eigenschaften (einschließlich Eltern-Kind-
Beziehungen), behalten jedoch ihre KE-ID bei. Nachdem Sie die Scantools-Umgebung beendet haben,
bleiben die verkleinerten KEs mit dem Style-KE verbunden und können in Pro/ENGINEER nicht mehr
regulär einzeln ausgewählt werden.

So verkleinern Sie Geometrie:

1. Ordnen Sie das Style-KE neu an, indem Sie es vor den KEs plazieren, die Sie verkleinern möchten.
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2. Wählen Sie die Befehlsfolge Geometrie > Geometrie verkleinern (Geometry > Collapse Geometry).
3. Wählen Sie im Modellbaum die KEs aus, die Sie verkleinern möchten.

Das System verkleinert die ausgewählten KEs und entfernt sie aus dem Modellbaum.
Hinweise:

Sie können das KE Geometrie verkleinern (Collapse Geometry) verwenden, um alte Scantools-
Elemente in das Style-KE zu importieren.

Beim Verkleinern einer analytischen Fläche in das Style-KE wird eine Fläche erzeugt, die nicht bearbeitet
werden kann. Anstatt die Fläche zu verkleinern, können Sie sie unter Verwendung der Befehlsfolge
Flaeche > Von Flaeche (Surface > From Surface) in das Style-KE kopieren. Dabei wird eine
Splinefläche erzeugt.

Allgemeine Einführung: KEs in Scantools
erzeugen
Sie können KEs in der Scantools-Umgebung erzeugen.

Hinweis: Innerhalb der Scantools-Umgebung erzeugte KEs sind interne KEs des Style-KE, und ein Zugriff
außerhalb von Scantools ist nicht möglich.

Wenn Sie die Scantools-Umgebung starten, wird in der Menüleiste das Menü Konstr Element (Feature)

angezeigt. Über das Menü Konstr Element (Feature) können Sie die folgenden KEs erzeugen:

� Kurve (Curve) — Anhand einer der folgenden Methoden eine Kurve erzeugen: aus Rohdaten, durch
einen Punkt.

� Flaeche (Surface) — Eine Fläche aus Kurven oder Flächen erzeugen.

� Roh (Raw) — Rohdaten aus einer Datei erzeugen.

Allgemeine Einführung: Kurven erzeugen
In Scantools können Sie unter Verwendung der folgenden Methoden Kurven erzeugen:

� Durch die Auswahl von Abtastkurven

� Durch die Auswahl von Bezugspunkten oder Eckpunkten, durch die die Kurve verlaufen soll

� Durch die Auswahl von Kurven oder Kanten

So erzeugen Sie Kurven aus Rohdaten
1. Wählen Sie die Befehlsfolge Geometrie > Kurve > Aus Beispieldaten (Geometry > Curve > From

Sample Data).
2. Wählen Sie die Rohdatensätze, aus denen Sie Kurven erzeugen möchten. Die von Ihnen erzeugten

Kurven werden grün angezeigt.

So erzeugen Sie Kurven durch Punkte
1. Wählen Sie die Befehlsfolge Geometrie > Kurve > Durch Punkt (Geometry > Curve > Through

Point).
2. Wählen Sie Bezugs- oder Eckpunkte.
3. Klicken Sie auf Fertig Ausw (Done Sel). Das System erzeugt eine Kurve, die durch die ausgewählten

Punkte verläuft.

So erzeugen Sie Kurven aus Kurven
1. Wählen Sie die Befehlsfolge Geometrie > Kurve > Von Kurve (Geometry > Curve > From Curve).
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2. Wählen Sie eine Option im Menü AUTOMATISCH (AUTOMATIC):
� Pkt Anzahl (NumberOfPnts) — Kurven mit einer bestimmten Anzahl von Punkten erzeugen.

Geben Sie die Anzahl der Punkte ein.

� Innerhalb Tol (Within Tol) — Kurven innerhalb der Toleranz erzeugen.

3. Wählen Sie die Kurven oder Kanten, aus denen Sie Kurven erzeugen möchten.

Allgemeine Einführung: Flächen erzeugen
Neue Flächen können auf zwei verschiedene Weisen erzeugt werden:

� Durch das Erzeugen einer Verbundfläche aus ausgewählten Kurven und Kanten

� Durch das Kopieren einer vorhandenen Verbundfläche

So erzeugen Sie Flächen aus Kurven
1. Wählen Sie die Befehlsfolge Geometrie > Flaeche > Von Kurve (Geometry > Surface > From

Curve).
2. Wählen Sie die Kurven oder Kanten in der ersten Richtung.
3. Wahlweise können Sie auch die Kurven oder Kanten in der zweiten Richtung wählen.
4. Geben Sie die Anzahl der Interpolationspunkte in der markierten Richtung ein.
5. Geben Sie die Anzahl der Interpolationspunkte in der zweiten Richtung ein.
6. Das System erzeugt unter Verwendung der von Ihnen ausgewählten Kurven eine Verbundfläche.

So erzeugen Sie Flächen aus anderen Flächen
1. Wählen Sie die Befehlsfolge Geometrie > Flaeche > Von Flaeche (Geometry > Surface > From

Surface).
2. Wählen Sie eine Fläche, die in das Style-KE kopiert werden soll.

Allgemeine Einführung: Editierwerkzeuge
Wenn Sie Scantools starten, sind im Menü Editieren (Edit) die folgenden Editierwerkzeuge aufgeführt:

� Widerrufen (Undo)/Noch einmal (Redo) — Letzte Aktion widerrufen oder wiederholen.

� Waehlen (Select) — Ein Objekt im Style-KE wählen. Wählen Sie einen Filter, um den zu wählenden
Objekttyp zu definieren. Wählen Sie einen der folgenden Filter: Ueber Filter (By Filter), Flaeche

(Surface), Sammelflaeche (Quilt), Kurve (Curve), Beispieldaten (Sample Data), Filteroptionen

(Filter Options).

� Loeschen (Delete) — Punkte, Bezugsebenen, Kurven und Flächen löschen.

� Aendern (Modify) — Kurven oder Flächen ändern.

� KE-Eigenschaften (Feature Properties) — Ein Style-KE umdefinieren, indem Flächen vereint und in
einen Volumenkörper konvertiert und Folien vereint werden.

� Auswahl-Voreinstellungen (Selection Preferences) — Die auswählbaren Elemente und
Markierungsoptionen definieren.

� Im Modellbaum auffinden (Find in Model Tree) — Unter Verwendung von Filtern im Modellbaum
nach einem Element suchen.

So legen Sie die KE-Eigenschaften fest
1. Wählen Sie die Befehlsfolge Editieren > KE-Eigenschaften (Edit > Feature Properties). Das

Dialogfenster Eigenschaften (Properties) erscheint.
2. Klicken Sie auf die Eigenschaften, die Sie festlegen möchten. Wählen Sie von den folgenden

Elementen:
� Flaech vereinen (Join Surfs) — Alle angrenzenden Flächen zu einer Sammelfläche vereinen.
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� Volumenkoerper (Make Solid) — Ein geschlossenes Volumen in einen Volumenkörper
konvertieren.

� Folien vereinen (Join Layers) — Folien aller ausgewählten Flächen vereinen.

3. Um Flächen von der Vereinigung auszuschließen, klicken Sie auf die Option Flaech ausschl (Exclude

Surfs) und wählen die auszuschließenden Flächen. Wählen Sie abschließend die Option Fertig (Done)

im Menü FLAECH AUSSCHL (EXCLUDE SRFS).
4. Zum Ändern des Linienstils klicken Sie auf Linienstil aendern (Modify Linestyle).
5. Klicken Sie im Dialogfenster Eigenschaften (Properties) auf OK.

Allgemeine Einführung: Kurven ändern
Sie können Kurven unter Verwendung einer der folgenden Methoden ändern:

� Durch das Verformen einer Kurve mit Hilfe des Steuerungspolygons

� Durch das Verformen einer Kurve mit Hilfe der Style-Punkte

� Durch das Anpassen einer Kurve an die angegebenen Referenzpunkte

So ändern Sie Kurven mit Hilfe des
Steuerungspolygons
1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie eine zu ändernde Kurve. Das Dialogfenster Kurve aendern (Modify Curve) wird

geöffnet.

3. Wählen Sie das Icon .
4. Definieren Sie die Bewegungsebene. Wählen Sie unter den folgenden Optionen: Kurvenebene (Curve

Plane), Definierte Ebene (Defined Plane) oder Ansichtsebene (View Plane).
5. Legen Sie die Richtung für das Verformen der Kurve fest. Sie können die Kurve in eine oder zwei

Richtungen verformen. Legen Sie die Richtungen fest, indem Sie eine der folgenden Optionen wählen:
Erste Richtung (First Direction), Zweite Richtung (Second Direction) oder Senkrechte Richtung

(Normal Direction).
6. Sie können nun einen Punkt wählen und diesen an die neue Position ziehen.
7. Klicken Sie wahlweise auf Bereich (Region), um den Bewegungsbereich des Polyeders zu definieren.
8. Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen

zu aktivieren.
9. Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
10. Um Schieberegler zu verwenden, wählen Sie einen Ziehpunkt aus, klicken auf Schubgelenke (Sliders)

und verschieben die Schieberegler in die gewünschte Richtung.
11. Klicken Sie auf OK, um die Operation abzuschließen.

So legen Sie Endbedingungen für Kurven fest
Wahlweise können Sie Bedingungen für jedes Kurvenende definieren.
1. Klicken Sie auf die Leiste Berandungsbedingungen (Boundaries Constraints).
2. Wählen Sie unter Bedingungen (Constraints) die Option Erstes Ende (First End) oder Zweites Ende

(Second End). Das gewählte Ende wird rot hervorgehoben.
3. Wählen Sie in einer Dropdown-Liste eine Bedingung, die Sie zuweisen möchten. Wählen Sie eine der

folgenden Optionen:
� Frei (Free) — Keine Bedingungen.

� Position — Das Ende wird an der aktuellen Position gehalten.

� Tangential (Tangent) — Ende tangential zu einer Referenz machen. Sie können lediglich
einseitige Kanten als Referenzberandung angeben.

� Kruemmung (Curvature) — G2-Kontinuität und Tangentialität zwischen der Kurve und der
Referenz festlegen. Sie können lediglich einseitige Kanten als Referenzberandung angeben.
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� Normal — Berandung an der ausgewählten Ebene ausrichten, so daß die Senkrechten entlang
dieser Berandung parallel zur Ebene verlaufen.

4. Wenn Sie keine Referenz für die Bedingung wählen, behält das System den aktuellen Status bei.

Bewegungsebenen für Kurven definieren
Wenn Sie eine Kurve ändern, können Sie unter Verwendung einer der folgenden Optionen eine
Bewegungsebene wählen:

� Kurvenebene (Curve Plane) — Die Bewegungsebene verläuft durch die Tangenten- und
Krümmungsvektoren des Punktes.

� Definierte Ebene (Defined plane) — Eine Bezugsebene als Bewegungsebene auswählen.

� Ansichtsebene (View plane) — Die Bewegungsebene verläuft durch den Punkt und ist parallel
zum Bildschirm.

So definieren Sie den Bewegungsbereich des
Polyeders für eine Kurve
Wenn Sie den Bewegungsbereich des Polyeders für eine Kurve definieren, können Sie folgendes festlegen:

� Die Regel für das Ändern der Kurve

� Berandungen der Region, in der sich die Kurve bewegen kann

So definieren Sie den Bewegungsbereich des Polyeders:

1. Klicken Sie auf die Leiste Bereich (Region). Im Dialogfenster wird der Abschnitt Bereich (Region)

geöffnet.
2. Wählen Sie im Dropdown-Listenfeld eine Option aus:

� Lokal (Local) — Es wird nur der gewählte Punkt bewegt.

� Stufenloser Bereich (Smooth Region) — Die Bewegung des Punktes wird nach kubischen
Gesetzen auf alle Punkte im angegebenen Bereich angewendet.

� Linearer Bereich (Linear Region) — Die Bewegung des Punktes wird nach linearen Gesetzen
auf alle Punkte im angegebenen Bereich angewendet.

� Konstanter Bereich (Constant Region) — Alle Punkte im angegebenen Bereich werden in
gleichem Abstand bewegt.

3. Für die Optionen Stufenloser Bereich (Smooth Region), Linearer Bereich (Linear Region) und
Konstanter Bereich (Constant Region) können Sie wahlweise die Berandungen des Bereichs wählen.
Klicken Sie auf die Schaltfläche Bereich (Region), und wählen Sie zwei Punkte auf der Kurve aus.

Hinweis: Standardmäßig ist die Option Stufenloser Bereich (Smooth Region) ausgewählt. Diese Option
wird auf die gesamte Kurve angewendet.

So ändern Sie Kurven mit Hilfe von Style-Punkten
1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie eine zu ändernde Kurve. Das Dialogfenster Kurve aendern (Modify Curve) wird

geöffnet.

3. Wählen Sie das Icon .
4. Bevor Sie Punkte verschieben, können Sie Style-Punkte auf der Kurve umdefinieren. Wählen Sie unter

Stilpunkte (Style Points) eine der folgenden Operationen:
� Hinzufuegen (Add) — Style-Punkte durch das Auswählen von Punkten auf der Kurve zur Kurve

hinzufügen.

� Loeschen (Delete) — Style-Punkte durch das Auswählen von Punkten von der Kurve löschen.
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� Neuverteilen (Redistribute) — Style-Punkte gemäß der Kurvenkrümmung neu verteilen.
Bereiche mit größerer Krümmung weisen eine dichtere Punktverteilung auf.

5. Um die Kurve zu verschieben, klicken Sie auf die Leiste InterpolPkt bewegen (Move Intrp. Point).
6. Definieren Sie die Bewegungsebene. Wählen Sie unter den folgenden Optionen: Kurvenebene (Curve

Plane), Definierte Ebene (Defined Plane) oder Ansichtsebene (View Plane).
7. Legen Sie die Richtung für das Verformen der Kurve fest. Sie können die Kurve in eine oder zwei

Richtungen verformen. Für zwei Richtungen können Sie eine Kombination aus zwei Optionen
verwenden. Wählen Sie unter den folgenden Optionen: Erste Richtung (First Direction), Zweite

Richtung (Second Direction) oder Senkrechte Richtung (Normal Direction).
8. Wählen Sie einen Punkt auf der Kurve, und ziehen Sie diesen Punkt.
9. Klicken Sie wahlweise auf Bereich (Region), um den Bewegungsbereich des Polyeders zu definieren.
10. Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen

zu aktivieren.
11. Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
12. Um Schieberegler zu verwenden, wählen Sie einen Ziehpunkt aus, klicken auf Schubgelenke (Sliders)

und verschieben die Schieberegler in die gewünschte Richtung.
13. Klicken Sie auf OK, um die Operation abzuschließen.

So ändern Sie Kurven mit Hilfe der Option
"Einpassen (Fit)"
1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie eine zu ändernde Kurve. Das Dialogfenster Kurve aendern (Modify Curve) wird

geöffnet.

3. Wählen Sie das Icon .
4. Geben Sie die Genauigkeit in das Feld Genauigkeit (Accuracy) ein.
5. Um die Kurve unter Verwendung der Standardeinstellungen anzupassen, klicken Sie auf Einpassen

(Fit).
6. Wahlweise können Sie Referenzpunkte einrichten. Um Referenzpunkte hinzuzufügen, wählen Sie die

Befehlsfolge RefPunkte einstellen > RefPkte hinzuf (Reference Points Setup > Add Ref Points),
und wählen Sie eine der folgenden Optionen aus der Dropdown-Liste:
� Rohdaten-Punkte (Raw Data Points) — Rohdaten-Punkte als Referenz wählen.

� Einzelpunkt (Single Point) — Einen Einzelpunkt als Referenz wählen.

� Bezugspunkt-Array (Datum Point Array) — Ein Bezugspunkt-Array als Referenz wählen.

Hinweis: Klicken Sie beim Umdefinieren von Referenzpunkten auf Zeigen (Show), um die aktuellen
Referenzpunkte anzuzeigen.

7. Klicken Sie auf den Auswahlpfeil, und wählen Sie Referenzpunkte aus.
8. Um Referenzpunkte zu entfernen, wählen Sie eine der folgenden Optionen aus der Dropdown-Liste:

Alle (All), Bezugspunkt-Array (Datum Points Array), Abtastkurvenpunkte (Scan Curve Points)

oder Einzelpunkt (Single Point).
9. Klicken Sie auf den Auswahlpfeil, und wählen Sie Referenzpunkte aus.
10. Nachdem Sie die Referenzpunkte eingerichtet haben, können Sie die Fläche erneut einpassen, indem

Sie auf Einpassen (Fit) klicken.
11. Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen

zu aktivieren.
12. Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
13. Klicken Sie auf OK, um die Operation abzuschließen.

Allgemeine Einführung: Flächen ändern
Sie können die Form einer Fläche unter Verwendung einer der folgenden Methoden ändern:

� Durch das Verformen einer Fläche mit Hilfe des Kontrollpolyeders
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� Durch das Verformen einer Fläche mit Hilfe des Rasters

� Durch das Anpassen einer Fläche an die angegebenen Referenzpunkte

So ändern Sie Flächen mit Hilfe des
Kontrollpolyeders
1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie die zu bearbeitende Splinefläche. Das Dialogfenster Flaeche aendern (Modify Surface)

wird geöffnet.

3. Wählen Sie das Icon .
4. Definieren Sie die Bewegungsebene. Wählen Sie eine der folgenden Optionen: Dynamische Ebene

(Dynamic Plane), Definierte Ebene (Defined Plane) oder Urspruengliche Ebene (Original Plane).
5. Legen Sie die Richtung für das Verformen der Fläche fest. Sie können die Fläche in eine oder zwei

Richtungen verformen. Für zwei Richtungen können Sie eine Kombination aus zwei Optionen
verwenden. Wählen Sie eine der folgenden Optionen: Erste Richtung (First Direction), Zweite

Richtung (Second Direction) oder Senkrechte Richtung (Normal Direction).
6. Sie können nun einen Punkt wählen und diesen an die neue Position ziehen.
7. Klicken Sie wahlweise auf Bereich (Region), um den Bewegungsbereich des Polyeders zu definieren.
8. Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen

zu aktivieren.
9. Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
10. Um Schieberegler zu verwenden, wählen Sie einen Ziehpunkt aus, klicken auf Schubgelenke (Sliders)

und verschieben die Schieberegler in die gewünschte Richtung.
11. Klicken Sie auf OK, um die Operation abzuschließen.

Bewegungsebene definieren
Wenn Sie eine Fläche ändern, können Sie unter Verwendung einer der folgenden Optionen eine
Bewegungsebene wählen:

� Dynamische Ebene (Dynamic Plane) — Die Bewegungsebene ist eine Tangentialebene, die durch den
ausgewählten Punkt verläuft. Die dynamische Bewegungsebene folgt dem ausgewählten Punkt.

� Definierte Ebene (Defined plane) — Eine Bezugsebene als Bewegungsebene auswählen.

� Urspruengliche Ebene (Original Plane) — Die Bewegungsebene ist eine Tangentialebene, die durch
die ursprüngliche Position des ausgewählten Punktes verläuft.

So definieren Sie den Bewegungsbereich des
Polyeders
Über den Bewegungsbereich des Polyeders können Sie folgendes festlegen:

� Die Regel für das Ändern der Flächenform

� Berandungen der Region, in der sich die Kurve bewegen kann

Sie können den Bewegungsbereich des Polyeders in eine oder zwei Richtungen verformen. Sie können für
jede Richtung eine andere Option festlegen.

1. Klicken Sie auf die Leiste Bereich (Region).
Im Dialogfenster wird der Abschnitt Bereiche (Regions) geöffnet. Die beiden Pfeile auf dem
Bildschirm zeigen die Richtungen der Rasterlinien an. Der blaue Pfeil gibt die erste Richtung der
Rasterlinien an, der rote Pfeil die zweite Richtung.

2. Legen Sie den Bereich der ersten Richtung fest, indem Sie eine Option aus der Dropdown-Liste
wählen:
� Lokal (Local) — Es wird nur der gewählte Punkt bewegt.
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� Stufenloser Bereich (Smooth Region) — Die Bewegung des Punktes wird nach kubischen
Gesetzen auf alle Punkte im angegebenen Bereich angewendet.

� Linearer Bereich (Linear Region) — Die Bewegung des Punktes wird nach linearen Gesetzen
auf alle Punkte im angegebenen Bereich angewendet.

� Konstanter Bereich (Constant Region) — Alle Punkte im angegebenen Bereich werden in
gleichem Abstand bewegt.

3. Für die Optionen Stufenloser Bereich (Smooth Region), Linearer Bereich (Linear Region) und
Konstanter Bereich (Constant Region) können Sie wahlweise die Berandungen des Bereichs in jeder
Richtung wählen. Klicken Sie auf die Schaltfläche Bereich (Region), und wählen Sie zwei
Kontrollpolylinien des Polyeders aus, um den Bereich in der angegebenen Richtung zu begrenzen.
Standardmäßig ist für den Bewegungsbereich des Polyeders die Option Stufenloser Bereich (Smooth

Region) ausgewählt. Diese wird auf die gesamte Fläche angewendet.
4. Legen Sie den Bewegungsbereich des Polyeders in der zweiten Richtung fest.

So verwenden Sie Schieberegler
Sie können Schieberegler verwenden, um Punkte mit größerer Genauigkeit zu verschieben.

So verwenden Sie Schieberegler:

1. Wählen Sie den zu verschiebenden Punkt.
2. Klicken Sie auf die Leiste Schubgelenke (Sliders).

Im Dialogfenster wird der Abschnitt Schubgelenke (Sliders) geöffnet. Sie können folgende
Schieberegler verwenden:
� Erste Richtung (First Direction) — Punkte werden in der ersten Richtung bewegt.

� Zweite Richtung (Second Direction) — Punkte werden in der zweiten Richtung bewegt.

� Senkrechte Richtung (Normal Direction) — Punkte werden senkrecht zur Fläche bewegt.

� Empfindlichkeit (Sensitivity) — Die Empfindlichkeit der Schieberegler- und Mausbewegungen
wird angepaßt.

3. Passen Sie die Fläche unter Verwendung der Schieberegler nach Bedarf an.

So ändern Sie Flächen mit Hilfe des Rasters
Sie können Flächen ändern, indem Sie deren Rasterlinien anpassen.

1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie die zu bearbeitende Splinefläche.
3. Das Dialogfenster Flaeche aendern (Modify Surface) wird geöffnet.

4. Klicken Sie auf das Icon , um die Rastermethode auszuwählen. Der Bereich Rasterlinien-

Aenderung (Gridlines Modification) wird im Dialogfeld Flaeche aendern (Modify Surface)

geöffnet.
5. Zum Hinzufügen oder Entfernen von Rasterlinien wählen Sie die Option Rasterlinien

hinzufuegen/entfernen (Add/Remove Gridlines). Das Dialogfenster Rasterlinien

hinzufuegen/entfernen (Add/Remove Gridlines) wird geöffnet.
6. Legen Sie fest, in welche Richtung die Rasterlinien geändert werden sollen, indem Sie eine der

folgenden Optionen wählen: Erste Richtung (First Dir) oder Zweite Richtung (Second Dir).
7. Zum Hinzufügen von Rasterlinien wählen Sie die Option Erste Richtung (First Dir) oder Zweite

Richtung (Second Dir), und klicken Sie auf Rasterlinien hinzufuegen (Add Gridlines).
8. Legen Sie fest, wo Sie Punkte auswählen möchten, indem Sie auf die Schaltfläche Flae anklicken

(pick on surf) oder Raster klicken (pick on grid) klicken.
9. Zum Auswählen eines Punktes klicken Sie auf die Auswahlpfeilschaltfläche, wählen einen Punkt aus

und klicken auf Fertig Ausw (Done Sel). Das System erzeugt eine Rasterlinie durch den von Ihnen
gewählten Punkt. Fügen Sie so viele Rasterlinien hinzu wie erforderlich.

10. Fügen Sie Rasterlinien in die andere Richtung hinzu.
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11. Zum Entfernen von Rasterlinien wählen Sie die Option Erste Richtung (First Dir) oder Zweite

Richtung (Second Dir), und klicken Sie auf Rasterlinien entfernen (Remove Gridlines). Klicken Sie
auf die Auswahlpfeilschaltfläche, und wählen Sie eine zu entfernende Rasterlinie aus. Wählen Sie
Fertig Ausw (Done Select).

12. Wenn Sie das Umdefinieren der Rasterlinien abgeschlossen haben, wählen Sie den Befehl Fertig

(Done). Das Dialogfenster Rasterlinien hinzufuegen/entfernen (Add/Remove Gridlines) wird
geschlossen.

13. Geben Sie die Punkttypen an, die für das Ziehen verwendet werden sollen. Wählen Sie unter Optionen

(Options) eine der folgenden Optionen:
� Steuerpunkte

� Interpolationspunkte

14. Definieren Sie die Bewegungsebene. Wählen Sie unter den folgenden Optionen: Dynamische Ebene

(Dynamic Plane), Definierte Ebene (Defined Plane) oder Urspruengliche Ebene (Original Plane).
15. Legen Sie die Richtung für das Verformen der Fläche fest. Sie können die Fläche in eine oder zwei

Richtungen verformen. Für zwei Richtungen können Sie eine Kombination aus zwei Optionen
verwenden. Wählen Sie eine der folgenden Optionen: Erste Richtung (First Direction), Zweite

Richtung (Second Direction) oder Senkrechte Richtung (Normal Direction).
16. Sie können nun einen Punkt wählen und diesen an die neue Position ziehen.
17. Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen

zu aktivieren.
18. Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
19. Um Schieberegler zu verwenden, wählen Sie einen Ziehpunkt aus, klicken auf Schubgelenke (Sliders)

und verschieben die Schieberegler in die gewünschte Richtung.
20. Klicken Sie auf OK, um die Operation abzuschließen.

So ändern Sie Flächen mit Hilfe der Option
"Einpassen (Fit)"
1. Wählen Sie die Befehlsfolge Editieren > Aendern (Edit > Modify).
2. Wählen Sie die zu bearbeitende Splinefläche. Das Dialogfenster Flaeche aendern (Modify Surface)

wird geöffnet.

3. Wählen Sie das Icon .
4. Definieren Sie die Bewegungsebene. Wählen Sie eine der folgenden Optionen: Dynamische Ebene

(Dynamic Plane), Definierte Ebene (Defined Plane) oder Urspruengliche Ebene (Original Plane).
5. In jeder Richtung können Sie die Rasterlinien festlegen, die das System für das Einpassen der Fläche

verwendet.
6. Um Rasterlinien in der ersten Richtung auszuwählen, wählen Sie die Option Untermengen-Raster 1.

Richtung (1st Direction Subset Grid), wählen rote Rasterlinien aus und klicken auf Fertig Ausw

(Done Sel).
7. Um Rasterlinien in der zweiten Richtung auszuwählen, wählen Sie die Option Untermengen-Raster 2.

Richtung (2nd Direction Subset Grid), wählen blaue Rasterlinien aus und klicken auf Fertig Ausw

(Done Sel).
8. Wenn Sie die Option Einpassen (Fit) mit der Standardeinstellung verwenden möchten, klicken Sie auf

Einpassen (Fit). Das System versucht die Fläche einzupassen.
9. Zum Übernehmen oder Ablehnen der Ergebnisse der Einpaßoperation wählen Sie im Menü AEND

AKTION (MOD ACTION) den Befehl Akzeptieren (Accept) bzw. Ablehnen (Reject).
10.  Wahlweise können Sie Bedingungen für die Einpaßoperation definieren, indem Sie die Einstellungen

für Optionen (Options) und RefPunkte einstellen (Reference Points Setup) festlegen.
11.  Um die Genauigkeit festzulegen, geben Sie den Wert für die Genauigkeit in das Feld Genauigkeit

(Accuracy) ein.
12.  Um den Versatz festzulegen, geben Sie den Wert für den Versatz in das Feld Versatz (Offset) ein.
13.  Um Referenzpunkte hinzuzufügen, wählen Sie die Befehlsfolge RefPunkte einstellen > RefPkte

hinzuf (Reference Points Setup > Add Ref Points).
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14.  Um Referenzpunkte anzugeben, wählen Sie eine der folgenden Optionen aus der Dropdown-Liste:
� Rohdatensatz (Raw Data Set) — Punkte aus einem Rohdatensatz wählen.

� Rohdaten-Punkte (Raw Data Points) — Einzelne Punkte aus einem Rohdatensatz wählen.

� Einzelpunkt (Single Point) — Bezugspunkte wählen.

� Bezugspunkt-Array (Datum Point Array) — Ein ganzes Bezugspunkt-Array wählen.

� Facetten-Eckpunkte (Facet Vertices) — Eckpunkte eines facettierten Modells wählen.

Hinweis: Klicken Sie auf Diagnose (Diagnostics), und aktivieren Sie die Anzeige Refer Punkte

(Reference Points), um Referenzpunkte im Modell anzuzeigen.
15. Klicken Sie auf die Auswahlpfeilschaltfläche, um hinzuzufügende Referenzpunkte zu wählen, und

klicken Sie auf Fertig Ausw (Done Sel).
16. Wenn Sie die Option Rohdatensatz (Raw Data Set) gewählt haben, wird das Menü ABTASTFILTER

(SCAN FILTER) angezeigt. Wählen Sie einen der folgenden Befehle:
� KrvKettFilter (CrvChainFltr) — Nur Abtastpunkte innerhalb des Bereichs verwenden, der durch

eine offene oder geschlossene Kurvenkette begrenzt ist. Geben Sie die Kurven, die Abtastpunkte
trennen, mit den Befehlen im Menü KETTE (CHAIN) an, und wählen Sie einen Abtastsatz.

� FlaePrjFilter (SrfProjFltr) — Nur solche Abtastpunkte verwenden, die innerhalb der
Begrenzungen der Fläche projizieren. Geben Sie den Abtastsatz an, der auf die Fläche projiziert
werden soll.

� Kein Filter (No Fltr) — Ganzen Abtastsatz auswählen.

17.  Um Referenzpunkte zu entfernen, klicken Sie auf RefPkte entf (RemRefPoints) und wählen eine der
folgenden Optionen aus der Dropdown-Liste: Alle (All), Abtastkurvensatz (Scan Curve Set),
Abtastkurvenpunkte (Scan Curve Points), Einzelpunkt (Single Point).

18.  Klicken Sie auf die Auswahlpfeilschaltfläche, und wählen Sie die zu entfernenden Referenzpunkte aus.
Wählen Sie Fertig Ausw (Done Sel).

19.  Oder klicken Sie auf Diagnose (Diagnostics), um die dynamische Anzeige der ausgewählten Analysen
zu aktivieren.

20.  Sie können auch auf Bedingungen (Constraints) klicken, um Berandungsbedingungen festzulegen.
21.  Klicken Sie auf OK, um die Operation abzuschließen.

 So aktivieren Sie dynamische Diagnosen
Beim Ändern der Geometrie können Sie die dynamische Anzeige von Analysen und Diagnosewerkzeugen
aktivieren oder deaktivieren. Die dynamische Anzeige wird entsprechend angepaßt, wenn Sie die
Geometrie ändern.

Es stehen die folgenden Diagnoseoptionen zur Auswahl: Steigung (Slope), Schnittkruemmung (Section

Curvature), Senkrechten (Normals), Nadelwalze (Porcupine), Abweichung (Deviation), Schneiden

(Intersection), Kosmetische Schattierung (Cosmetic Shading), Netz (Mesh), Raster (Grid),

Referenzpunkte (Reference Points). Über das reguläre Menü Analyse (Analysis) können Sie auf weitere
Analysewerkzeuge zugreifen.

1. Klicken Sie auf die Leiste Diagnose (Diagnostics). Im Dialogfenster wird der Abschnitt Diagnose

(Diagnostics) geöffnet.

2. Wählen Sie eine Analyse aus der Dropdown-Liste aus, und klicken Sie auf das Icon , um sie
anzuzeigen.

3. Für die Analysen Steigung (Slope) und Schnittkruemmung (Section Curvature) müssen Sie
zunächst eine Referenz wählen. Klicken Sie auf die Schaltfläche Referenz (Reference), und wählen

Sie die gewünschte Referenz. Klicken Sie anschließend auf das Icon , um die Anzeige zu
aktivieren.

4. Um die Analyse auszublenden, wählen Sie eine Analyse aus der Dropdown-Liste aus, und klicken Sie

auf das Icon , um die Anzeige zu deaktivieren.
5. Um Einstellungen für eine bestimmte Analyse zu ändern, wählen Sie eine Analyse aus der Liste und

klicken auf Einstellungen (Settings). Im Dialogfenster Darstellungseinstellungen (Display Settings)

können Sie Parameter für die ausgewählte Analyse festlegen.



Pro/SCAN-TOOLS 21

So legen Sie Berandungsbedingungen für
Flächenänderungen fest
Sie können für jede Flächenberandung eine Bedingung definieren.
1. Klicken Sie auf die Leiste Berandungsbedingungen (Boundaries Constraints).
2. Wählen Sie unter Bedingungen (Constraints) eine Berandung aus der Liste aus. Die gewählte

Berandung wird rot hervorgehoben.
3. Wählen Sie in einer Dropdown-Liste eine Bedingung, die Sie der gewählten Berandung zuweisen

möchten. Wählen Sie eine der folgenden Optionen:
� Frei (Free) — Keine Bedingungen.

� Position — Die Berandung wird an der aktuellen Position gehalten.

� Tangential (Tangent) — Tangentialität zwischen der Berandung und der Referenzfläche
festlegen. Sie können lediglich einseitige Kanten als Referenzberandung angeben.

� Kruemmung (Curvature) — G2-Kontinuität und Tangentialität zwischen der Berandung und der
Referenzfläche festlegen. Sie können lediglich einseitige Kanten als Referenzberandung angeben.

� Normal — Berandung an der ausgewählten Ebene ausrichten, so daß die Senkrechten entlang
dieser Berandung parallel zur Ebene verlaufen.

4. Um die Bedingungen festzulegen, klicken Sie auf die Auswahlpfeilschaltfläche.
5. Wählen Sie eine Bedingung aus dem Menü BEDINGUNGEN (CONDITIONS) aus.

� Raster lassen (KeepGrid) — Fläche an den vorhandenen Rasterlinien ausrichten, ohne neue
Rasterlinien hinzuzufügen.

� Innerhalb Tol (WithinTol) — Fläche an der Referenzberandung ausrichten, so daß die
Abweichung innerhalb der Teilegenauigkeit liegt. Beim Ausrichten der Fläche werden weitere
Rasterlinien hinzugefügt, bis die Ausrichtung und die Tangentialität innerhalb der Toleranz liegen.

6. Wählen Sie anschließend den Befehl Fertig (Done).
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